Applicant
Name: Amanda Klinger

Community College: Davidson County Community College

Department: Mathematics

Phone: 336.751.2885 ext. 6324

Email: apklinger@davidsonccc.edu

To which course will this project add global or regional content, context or connections?

MAT 155 – Statistical Analysis and MAT 155A – Statistical Analysis Lab
(Could be adapted for use with MAT 151 – Statistics I and MAT 151A – Statistics I Lab)

How many students enroll in this course per academic year?
25 students per class; I teach 2 – 3 classes per year
MAT 155 – Statistical Analysis

1. Course Number and Course Description.

MAT 155 – This course is an introduction to descriptive and inferential statistics. Topics include sampling, distributions, plotting data, central tendency, dispersion, Central Limits Theorem, confidence intervals, hypothesis testing, correlations, regressions, and multinomial experiments. Upon completion, students should be able to describe data and test inferences about populations using sample data.

MAT 155A – This course is a laboratory for MAT 155. Emphasis is placed on experiences that enhance the materials presented in the class. Upon completion, students should be able to solve problems, apply critical thinking, work in teams, and communicate effectively.

2. Description of Module

This module was used to expose students to data and statistics worldwide. It increased geographical awareness as well as introduced statistical concepts using international data.

The students were split into eight groups with three members in each group. Each group was formed based on their personal interests using a quick voluntary survey. They were placed into one of the following eight global issues: Human Rights, Environment, Poverty, Health, Media, Economy, Geopolitics, and Education. Each member of the group then spent a little time researching their issue in order to choose a country to focus on for the project.

During lab at the beginning of the semester, the students were given directions and guidance on how to setup a website using Weebly for Education to store the group international project. The website was created so that each group had a Home page, a country page for each student and a blog page. The home page was a group effort and the country pages were created by the individual student. The students added maps, graphs, statistics, images, comments, and other instructor directed materials into the website throughout the first half of the semester.

3. Objectives

Upon completion of this module students should be able to:
- Design an interesting website with an international theme using statistics
- Gather interesting global statistics from online sources
- Find raw data from online sources and analyze it
- Interpret calculations, charts and graphs in context
- Gain an awareness of other countries using statistics

4. Methodology

Lectures – Various lectures included examples of statistics from around the world using different methods like the following:
- Example problems were worked on the board and could be cited using a picture of the instructor’s notes or the student’s notes from class.
- Videos or TEDtalks were watched and discussed in class. The student could then use the link on their website by posting it with a brief comment.

Labs – Labs consisted of the following:
• Step-by-step Excel examples followed by a “do-it-yourself” part
• Instructor-led Internet activity
• Construction and periodic review of websites

Labs Represented in Student Websites – Full labs added as attachments
1. Qualitative vs. Quantitative Data
2. Observational Study vs. Experiment
3. Descriptive Statistics Using International Weather Data from the University of Dayton
4. Bar Charts by Issue Using Nationmaster
5. Creating Boxplots with Mortality Rates Using The World Bank -
6. Analysis of Data - Correlation and Regression Using Gapminder
7. Probability and Proportions Using Worldmapper Data

Blogs – This area was completely student driven. Students were given prompts and asked to comment on other student websites to make the projects more interactive.
Examples used for websites this past semester were:
• Students posted the following question as a group, “Can you find an interesting statistic about my global issue(s)?” Each student was required to comment on at least one other group website.
• As a group, students posted a video representing their specific social issue. Each student was required to watch each group’s video and comment about the statistics used in the video.

Presentation – At the end of the semester, the students then gave a brief presentation through web conferencing software called Blackboard Collaborate to the entire school. Faculty, staff and students were invited to attend by clicking on a link to watch the presentation.

5. Evaluation

Students completed a website much like an online portfolio using material from class and information gathered on their own and as a group. This website was viewed and graded by the instructor at the end of the semester. This project counted 10% of the final grade in the course. The breakdown of the entire course is as follows:
• Homework 15%
• Labs 15%
• Tests 50% – The website will count as one of the 5 test grades during the semester.
• Final Exam 20%
The completed grading rubric is attached.

6. Resources
Weebly for Education (http://education.weebly.com/) - This site allows instructors to have up to 40 student websites in a class and gives the instructor access to each student’s site. It is a free service and each student has a password protected site. The Weebly interface is very user-friendly and the students really enjoyed playing around with it.

Gapminder (http://www.gapminder.org/) – This site was founded by Hans Rosling, a Swedish medical doctor, academic, statistician and public speaker. The theme that the site boasts is, “a fact-based worldview.” Graphs are created to show different countries at different points in time as it follows different variables. The students learn about correlation using these graphs.
The following is a link to a video that shows some of the Gapminder statistics which I show before talking about the website.
http://www.gapminder.org/videos/200-years-that-changed-the-world-bbc/

Worldmapper (http://www.worldmapper.org/) – This site is a collection of world maps, where territories are re-sized on each map according to the subject of interest. Using this website, the students learn about proportion through maps.

Ted (www.ted.com) – This website was used to show a few different videos during lectures. The following are some really good “tedtalks.”
- The following video is used as an introduction to the course to show that statistics can be everywhere. Chris Jordan depicts statistics of Western Culture through art. http://www.ted.com/talks/chris_jordan_pictures_some_shocking_stats.html
- Many TedTalks on global issues that can be used in student blog posts

Creative Commons – A website designed to help search images and videos that have waived their rights to copyright. This was used along with the built-in search feature in Weebly to add various images and videos to the student websites. http://search.creativecommons.org

The following sites were used for data extraction on specific countries or regions:
- US Census www.census.gov
- World Bank www.worldbank.com
- University of Dayton Archived Weather Data http://academic.udayton.edu/kissock/http/Weather/citylistWorld.htm
- Nationmaster www.nationmaster.com
Global Statistics Project
This project is a compilation of work throughout the first half of the semester in Elementary Statistics.

I. Getting Started and Assignment 1
   a. On the first day of class, the project was introduced to the students. Each student completed a survey to assess their interests in different global issues. The survey is titled MAT 155 – Introductory Survey and is attached.
   b. On the first day of lab, the students were asked to sit in their groups and research their issues. The goal was to have the students choose a country that is dealing with the group issue.
   c. The students were then instructed to begin creating their websites using the attached document titled Weebly for Education Website – Getting Started (Part 1 of Assignment). This document instructed the students to design their website using a Weebly theme and then to add five pages: A home page, three country pages and a blog page. They were also instructed to add an image on the home page representing their issue and then Publish the page.
   d. In order to follow copyright laws the above document was amended to include information about adding images. Document attached is Adding Images and Videos in Weebly.
   e. The second part of the first assignment followed our classroom discussion. It was to create a table or list on the home page. Use the World Factbook website. Choose one quantitative and one qualitative variable and record the data for each one of your three countries. The following is a screen shot of a completed Home page for the Health group.

II. Assignment 2 – Blog
The second assignment was completed as a group and as an individual. The assignment was: One person from each group should post the following comment on your Blog page: Can you find an interesting statistic about my global issue(s)?
Each individual student in class should then log onto a different class website and post a Blog comment - This should be a statistic that you find online dealing with the Global issue of that website.
This assignment allowed the students to see what other groups were doing in their websites and to see other global issues.
The following is a screen shot from the completed Blog page of the Poverty group.
III. Assignment 3 – Internet Research
This assignment was an individual assignment that followed the class discussion. The students were instructed to:
Find one observational study or one experiment online that references your country and your issue. Link the website for the study to your country page. State clearly whether it is an observational study or an experiment. Briefly describe in a few sentences why you think it is an observational study or experiment.
The following is a screenshot of a student that chose Mexico as a country to focus on for the global issue of Education. The observational study he chose is at the bottom with a link to the actual study on the Internet.
IV. Assignment 4 – Graphs

This assignment was to complete Lab 5 - Bar chart of individual country and post on country page; Bar chart of comparison of countries and post on home page. The lab was created in Excel with specific instructions on how to construct a graph and post the graph to the webpage. The group assignment was to work together to create a Side-by-side bar graph with all three countries represented to add to the Home page. The lab is attached and it is titled MAT 155 – Organizing Data in Excel. These labs were created specific for each issue because gathering the data was rather difficult. Below is a screen shot of the Home page bar chart for the Media group and of the individual bar chart for the student that chose Japan in this same group.
Assignment 5 – Descriptive Statistics
This assignment used raw data on weather from the University of Dayton. The students were instructed to complete Lab 6 (attached as MAT 155 – Weather Data). Then they were to post the results for the descriptive statistics of their country in their individual page along with an image representing the weather in their country.
Below is a screen shot for the Economy group and a student that chose Germany.

Descriptive Statistics from Excel Using Daily Temperatures for January 1995 and January 2012 in Fahrenheit and Celsius Degrees

<table>
<thead>
<tr>
<th>January 1995</th>
<th>January 2012</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean: 29.803221</td>
<td>Mean: 34.228711</td>
</tr>
<tr>
<td>Median: 29.3</td>
<td>Median: 35.92</td>
</tr>
<tr>
<td>Mode: 13.6</td>
<td>Mode: 28.3</td>
</tr>
<tr>
<td>St Dev: 10.37129</td>
<td>St Dev: 6.811543</td>
</tr>
</tbody>
</table>

Assignment 6 – Video
The students were instructed to:
As a group find a video about your issue and either embed or post link on the blog page (Please ask instructor if you need help with this). Then as an individual, comment on all other group videos.

The following is a screen shot of a video post for the Environmental issues group.

VII. Assignment 7 – Box plot
This was a lab assignment. The results of which were then posted to the website. The box plots were created using the World Bank website on the topic of Mortality Rates by Continent. The students chose two years from the data results to compare in box plot form. The lab is attached, and it is titled **MAT 155 – Boxplots**.

Below is a screen shot from the Geopolitics group and the country Egypt.
VIII. Assignment 8 – Gapminder
This lab went along with the class discussion of linear regression and correlation. The Gapminder website was introduced in class using a video posted by the founder of the website, Hans Rosling. The students really enjoyed this website. The assignment was to find two variables from their specific country that showed a positive correlation and two that showed a negative correlation as time passed. They were also asked to show a graph representing their three countries that showed how income and life expectancy related as time passed. The lab is attached and titled Gapminder Analysis of Data.
The first graph is from the Home page of the Human Rights group that shows all three countries. The second graph is from the Media group and the UK page.

IX. Assignment 9 – Worldmapper
This last assignment went along with probabilities and proportions from class. The Worldmapper website shows maps as proportions of different variables. The students were instructed to complete a Moodle quiz (attached as Preview Lab 10 – Worldmapper Lab) in order to become familiar with the website. They were then instructed to complete the follow up (attached as MAT 155 – Probability and Proportions). This explained what to put in the website to show a proportion map.
Below is a screen shot of the Democratic Republic of the Congo student page in the Health group.

![Malaria Deaths](http://www.worldmapper.org/images/argepng/230.png)

This map represents the number of malaria deaths. While there were most malaria cases in Southeastern Africa, there were most deaths in Central Africa.

X. Student Presentations (attached title – International Presentations on BB Collaborate)
In order to present these websites, the groups were split into four different key talking points: Website Creation, Website Content, Challenges of the Project and What You Learned. These presentations were setup through Blackboard Collaborate in order to allow anyone to join the presentation across campus. The students had to submit key talking points a week in advance and they had to write down an interesting fact about their country and issue that they learned through the project. This was then the start or end of each presentation.

XI. Grading – Rubric attached (MAT 155 International Project – Grading Rubric)
The students had access to this rubric throughout the project. It was posted in Moodle along with each assignment.

Project Follow-Up
There are a few things that I will change or revise when attempting this project in the spring.
- I will add more to the Blog portion of the website assignments. This seemed to be the part that the students had the most fun with.
- I will add more to the student presentations and make them a little more thought out.
- I will allow for student assessment of each group member in the grading rubric.
MAT 155 - Introductory Survey

This survey is completely voluntarily, but it will be used to help put together strong groups.

1. Do you consider yourself good with computers?
2. Do you enjoy browsing the Internet?
3. Do you like working with numbers or data?
4. Do you like taking polls online?
5. Are you an organized person?
6. Are you a “people person”?
7. Do you have a habit of being late or absent?
8. Do you like to or would you like to travel the world?
9. Do you find the world interesting?
10. Have you ever had a statistics course?
11. How many states outside of NC have you traveled to (not just driven through)?
12. How many countries outside of the US have you traveled to?

Rank the following international issues in order of interest with 1 being most interesting and 8 least interesting.

_____ Human Rights (Democracy, Racism, Women’s rights, Freedom of religion, Freedom of opinion, Minority rights, etc.)
_____ Environment (Sustainable development, Global warming, Climate change, Energy security, Biodiversity, Nature and animal conservation, Coral reef conservation, etc.)
_____ Poverty (World hunger, Child mortality, Foreign aid for development assistance, Food and agriculture, Corruption, etc.)
_____ Health (Diseases like AIDS and malaria, Tobacco, Obesity, Water and development, Illicit drugs, etc.)
_____ Education (Job training, Female education rights, primary school education, lack of access, etc.)
_____ Mainstream Media (War, Propaganda and the media, Media manipulation, Corporate influence in the media, Media in the US, Global warming spin and the media, Health in the media, etc.)
_____ Economy (Global financial crisis, Child labor, Banana trade, Fair trade, Foreign aid, Consumerism, Corporate power, Water and development, etc.)
_____ Geopolitics (Terrorism, Torture, Trafficking, Slavery, Arms trade, Military spending, Training human rights violators, Small arms, Landmines, Nuclear weapons, Democracy, etc.)
Weebly for Education Website – Getting Started (Part of Assignment 1)

How to Login:
Students can log in at http://students.weebly.com. You should see the following login page.

![Login Page]

The username is one of the following based on the issue assigned to your group.
Morning class: group1hum, group2env, group3pov, group4hea, group5med, group6eco, group7geo
Afternoon class: groupahr, groupbpov, groupchea, groupdenv

The starting password is your group and number/letter. For example if you are in Group1, then your password is all lowercase with no spaces – group1.

The first time your group logs in, you will see the following:

![Enter Website Title]

Name your website based on the issue assigned to your group and press Save Title.

You should see the following tool box at the top of your page.

![Tool Box]

Notice that the Elements tab is selected and what is showing are the Basic Elements that can be added to your page.

How to Get Started:
Press the Design tab as shown below and search through the Favorites or select All Themes to choose a Theme for your website that is satisfactory for the entire group.

![Design Tab]

Select Design Options and turn the Phone number field OFF. The rest of the Design Options should change based on your Theme. So choose a good Theme and do not worry about the Options. Choose a theme with a picture on the front page.
**Adding Picture to Cover Page:**
Open a new tab and go to Google.com and click on Images at the top of the page. In the search bar type your group’s global issue. Follow the steps below to add to page:
- Find an image that is not too graphic and click on it.
- Click on Full Size Image on the right.
- Highlight the URL, right click on it and select Copy.
- Go back to the Weebly site.
- Scroll over the image on the Front and select Edit Image.
- Press the red x to remove the existing image.
- In the upper left corner, click on Add Image.
- In the dialog box select Image URL.
- Right click in the bar and select paste to add the image found from Google.
- Press Insert.
- There are other image effects that you can play around with if time permits.
- In the upper right corner, you must press SAVE to keep the image on your website. Choose Save and select – Only for this page.

**Adding Pages:**
Press the Pages tab in the Tool bar at the top. This part is easy to follow. Use image below to help.

You will then add a Blog the same way the pages were added except you will click on ADD BLOG.
Adding Images and Videos in Weebly

I. Use the Search feature built into Weebly. This search uses Flickr images.
   1. Add a picture element or Edit an existing image and select Add Image.
   2. Select the Search Category in the next window.
   3. Type the criteria for the search (the group issue or country) and select the Free Photos tab.
   4. Select the photo. Crop and arrange photo in webpage and save.

II. Use the Creative Commons where rights to images are free.
    http://search.creativecommons.org/ - Search Creative Commons collections using various search engines.
   1. Type search criteria in the search field and click on a specific search engine to use.
   2. If you click on Google Images: (This would be the best search to find maps)
      a. Select image.
      b. Click on Full Size Image on the right.
      c. Highlight the URL, right click on it and select Copy.
      d. Go back to the Weebly site.
      e. Scroll over the image on the Front and select Edit Image.
      f. Press the red x to remove the existing image.
      g. In the upper left corner, click on Add Image.
      h. In the dialog box select Image URL.
      i. Right click in the bar and select paste to add the image found from Google.
      j. Press Insert.
      k. There are other image effects that you can play around with if time permits.
      l. In the upper right corner, you must press SAVE to keep the image on your website. Choose Save and select – Only for this page.
   3. If you click on Pixabay Images:
      a. Select Image.
      b. Click on Download in the upper right corner and select the first jpg option.
      c. The picture will now be linked to a URL and you will follow the instructions as stated in Part c through Part j of the Google images above.
   4. If you click on Open Clip Art Library:
      a. Select image in the bottom portion of the screen. The images on the top row are not free.
      b. You must change the image to a .png file by typing in a resolution into the box beside png as shown in the image following. The default resolution is 800. If you make this number smaller, the image will be smaller.
      c. Copy the URL and paste into Weebly the same as Part c through Part j of the Google images above.

III. Use The Morgue – A public image archive where rights to images are free.
    http://morguefile.com/ - Public Image Archive
1. Search for a picture on the website using the group issue or country as a keyword. Make sure that the tab Free Photos is selected before completing search.
2. Click on the image that you select.
3. Copy the image URL located in the lower left corner.
4. Past the image URL in a new Window or Tab and press enter. This will give you a longer URL with a .jpg ending to paste into Weebly.
5. Copy the new URL and switch back to the Weebly website.
6. Select Edit Image and delete previous image by clicking on the red x.
7. Click on Add new image in the upper left corner.
8. Select Image URL and paste the URL in this bar. Press Insert.
9. Edit or crop image and press Save if directed.

IV. Use the creative commons for videos on YouTube as well.
1. Click on the Creative Commons website http://search.creativecommons.org/
2. Type in search criteria and select YouTube video.
3. This will direct you to YouTube and you should also see creative commons beside your search criteria in YouTube.
4. Click on Share below the YouTube video and copy the URL.
5. You can add YouTube videos to the Blog portion of your website easily.
7. Drag the YouTube element into the Post box.
8. Click on the video and paste the URL into the blue box and your video will change instantly.
9. Select Publish Live and close the window that will pop up saying that your post was published to the website.
MAT 155 - Organizing Data in Excel
Geopolitics Issue - Bar Chart

I. Find Data using the Nationmaster website
1. Go to www.nationmaster.com
2. Click on Countries A-Z.
3. Select your country in the list.
4. Choose Terrorism in the list of Facts and Figures.
5. At the bottom of the list click on View all Terrorism stats.

II. Open Excel and Type Data
1. Open a blank worksheet in Excel.
2. In cell A2, type Outcome.
3. In cells A3 through A5, type each outcome: Fatalities, Incidences, Injuries
4. In cell B1, type: (the name of your country).
6. Complete the chart using the data for your country on the NationMaster website.

III. Construct a Bar Graph
1. Highlight all data and headings excluding the name of the country in B1.
2. From the Menu Bar, click on the Insert tab.
   Select the Column icon . Then choose the clustered column for this bar chart.
3. Note a title will automatically show in the chart. Double click on the title to make changes. Add the name of your country to the title and the year when the statistics were collected.
4. Since we only have one color of bars, we do not need a legend. Click on the legend on the left side of the chart and press Delete to remove it.
5. Label the horizontal axis. Under Chart Tools, click on the Layout tab and select Axis Titles (NOT the icon that just says Axes). Select Primary Horizontal Axis and choose Title Below Axis. Rename this appropriately to correspond with the bars on the graph.
6. Label the vertical axis. Under Chart Tools, click on the Layout tab. Click Axis Titles and choose Primary Vertical Axis Title, then Rotated Title. On your graph, highlight the words “Axis Title” and rename it appropriately in reference to the numbers on the vertical axis.
7. Change the look of the graph (optional). To change the color of the bars on the graph, right click once to select all the bars. Left click again to select only one bar. Right click on the bar and choose Format Data Point. The Fill option will change the color of the bar; you can change the color, gradient or texture of the bars.

IV. Add Excel Chart to Website
1. Open the Paint program in Windows. Click on Start and All Programs. Select the Accessories folder and choose Paint.
2. Click on the Bar Chart in Excel and make sure the light blue outline appears around the chart. Under the Home tab click on the Copy icon or right click on the chart and select Copy.
3. Switch to the Paint program and paste the chart into the white area using either the Paste icon or right click and choose Paste.
4. Click anywhere in the gray region of the Paint program to unselect the chart. Move the white region of Paint to match with the corner of the chart.
5. Click on the Save icon and save the Chart image as a PNG, JPG, or GIF file. JPG is generally the one used for images. Save it to My Documents or the Desktop to easily find it again.
6. Open an internet browser and go to your website. Add the image to the page for your country using the "Upload a photo from your computer" option.

V. Group Assignment -- Construct a Side-by-Side Bar Graph to Compare Countries
1. Select one person from the group to type additional data into Excel. (In the group of 4, the 4th person will construct this graph).
2. In cells C1 and D1, type the names of the other two countries in your group.
3. Add the information that corresponds to the other two countries below each heading.
4. From the Menu Bar, click Insert.
5. Highlight all data and headings including the name of each country.
6. Click Column and select the 1st item, Clustered Column. Your graph should be similar to the one from before, but with three columns clustered together.
7. We do want to keep the legend this time, but it should just be the name of each country. To edit legend entries, click on Chart Tools click Design and choose Select Data.
8. Click on the words representing the first entry, click Edit, type new entry, and click OK.
9. Repeat the process for other entries.
10. Add a Chart Title by clicking on the Layout Tab, the Chart Title icon and selecting Above Chart.
11. Label the horizontal and vertical axes appropriately as shown in the individual charts.
12. Post this graph to the Home page of your group website.
13. Below the graph, add a brief description of what the graph represents.
MAT 155 – Weather Data
International Descriptive Statistics

*The data used in this lab is from the University of Dayton and can be found at http://academic.udayton.edu/kissock/http/Weather/citylistWorld.htm

I. Load Data
1. Click on the link in the lab description of Moodle to find the online weather data.
2. Select the appropriate data that matches your country. If you do not see a city from your country, click on the link to find the closest city to your country in Moodle.
3. Note how to read the data. The following shows a snapshot of some data. This data is from Month 1 = January, Days 1 – 9, Year 1995 and the temperature is given in °F. The data should go all the way to the year 2012. If you see a -99 in the temperature column that generally means that there was no data value for that day.

<table>
<thead>
<tr>
<th>Month</th>
<th>Day</th>
<th>Year</th>
<th>Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1995</td>
<td>40.1</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>1995</td>
<td>42.3</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>1995</td>
<td>36.5</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>1995</td>
<td>36.3</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>1995</td>
<td>38.5</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>1995</td>
<td>42.2</td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>1995</td>
<td>46.3</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>1995</td>
<td>47.6</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>1995</td>
<td>43.5</td>
</tr>
</tbody>
</table>

II. Create Excel Spreadsheet
4. Open a blank Excel spreadsheet.
5. Title the columns as follows: A1 is Month, B1 is Day, C1 is Year, D1 is F Temp, and E1 is C Temp. Adjust the column width if needed. Use the same titles for G1 through K1 (Month, Day, Year F Temp and C Temp).
6. Switch to the website of data. Copy the data for January 1995 and paste into cell A2 of the Excel sheet.
7. Note that the data copied as one column so we have to split it into the four columns.
8. Highlight column A to select all of the data.
9. Click on the Data tab. In the Data Tools section select Convert Text to Columns icon.
10. In Step 1 of the Wizard, Fixed width should be selected. Then press Next.
11. The preview of your data should now be split into four columns. Click Next.
12. Leave the Data Format on General and press Finish.
13. You should now have data in the first four columns A through D.
14. In column E, we will tell Excel to convert Fahrenheit to Celsius degrees.
15. Click on cell E2. Press the function icon beside the formula bar.
16. Type Convert in the Search box and select Go.
17. Select the Convert function.
18. Beside Number, type or click on the cell for the first value that you want to convert. Complete the box as follows. Type in F for Fahrenheit and C for Celsius. Excel will automatically put the quote marks. Note that the F and C must be capital letters.
19. Fill down the column to convert all temperatures to Celsius.
20. Delete any values of -99 and the corresponding Celsius temperatures from your data sets if you have any. To do this, just click on the cell and press the Delete key.
21. Repeat the steps above to copy the temperatures for January 2012. (You will scroll all the way down to almost the end of the data in the website to find 2012). Paste the data in cell G2. Start with converting the data in #8 and repeat everything to #20 with the new data.
22. Now you should have all the data to create the descriptive statistics of January temperatures for your country.

III. Calculate Descriptive Statistics in Excel
24. The first statistic you will calculate is the mean. Type the word Mean in cell C35 and in cell I35.
25. To calculate this we use a built in function in Excel. Click on cell D35 and type: 
   =AVERAGE(D2:D32) and press Enter. Now find the mean for column J in cell J35. This gives the average temperature for January in F0. Now in cells E35 and K35, find the mean for Celsius degrees in both years.
26. The next statistic is Median. Type the word Median in cells C36 and I36.
27. Click on cell D36 and type:  =MEDIAN(D2:D32) and press Enter. Find the median in C0 in cell E36. Then find the two median temperatures for 2012 in cells J36 and K36.
28. Now find the Mode. Type the word Mode in cells C37 and I37.
29. Click on cell D37 and type:  =MODE(D2:D32) and press Enter. Find the mode in C0 in cell E37. Then find the two median temperatures for 2012 in cells J37 and K37.
30. The last statistic is Standard Deviation. Type the following into cell C38 and I38: St Dev.
31. Click on cell D38 and type:  =STDEV(D2:D32) and press Enter. Find the standard deviation in C0 in cell E38. Then find the two standard deviations for 2012 in cells J38 and K38.
32. Save this lab as Descriptive Stats and post to Moodle under Lab 6.

IV. Post Descriptive Statistics to Website
   Follow the instructions below so that everyone has the same chart on their website.
33. In Moodle, click on the words Weebly beside International Project to open the sign in page to your website. Type in your Username and Password and Log in. Click on Edit Site.
34. Select the page for your country.
35. Drag down a “Title Text” box to the very bottom of your page.
36. Type the following title: Descriptive Statistics from Excel Using Daily Temperatures for January 1995 and January 2012 in Fahrenheit and Celsius Degrees.
37. Drag down a “Multiple Column” box below the title page. Change the number of columns to 3.
38. In the first column, drag down a “Paragraph with Title” box. In the title part, type January 1995.
39. Switch to the Excel. Open your completed lab if you already closed it. Highlight the calculations from C35 over to E35 and down to E38. This should include all of the created statistics for 1995. Copy the data by right clicking on it or clicking on the icon.
40. Switch back to the Weebly website.
41. Paste the statistics below the title in column 1. Press Enter right before each statistic title to create a nice table.
42. Repeat #38 - #41 except the column title should be January 2012 in column 2 of the website.
43. Drag and drop a “Picture” box into column 3.
44. Click on the Image box and select the Search tab.
45. Type the name of your country in the Search bar and press Enter. Make sure the Free Photos tab is selected when Images appear.
46. Select an image that shows the scenery in your country.
47. Publish your results.
MAT 155 – Boxplots
International Lab using Mortality Rates
All data was found on The World Bank website: data.worldbank.org

I. Open Data
1. Log into Moodle.
2. Click on Assignments in the International Project section.
3. Click on Mortality Data in Assignment 7 to open an Excel spreadsheet.

II. Calculate Five-Number Summary
4. Before doing anything in the spreadsheet. Click File and Save As. Save the lab as Boxplots-Your Name.
5. At the bottom of the spreadsheet, each page is titled by continent. Select the continent tab that contains your country. Note the first tab is a compilation of all of the data from the World Bank website.
6. Scroll to the bottom of the data set. Skip a few rows and type the word Statistics in column B after the data. Type the following titles in the cells below it like the following:

| Statistics | Q1 | Min | Median | Max | Q3 |

The words must be in the correct order to create a box plot.
7. Copy the row of years across the top of the data set and paste them beside the word Statistics at the bottom of the sheet.
8. Click on the cell beside Q1 and type the following formula: =QUARTILE(select all of the data below the year 1995, 1). Press Enter. Note that the number 1 at the end of the formula calculates the first quartile.
9. Click on the cell beside Min and type the following formula: =MIN(select all of the data below the year 1995). Press Enter.
10. Click on the cell beside Median and type the following formula: =MEDIAN(select all of the data below the year 1995). Press Enter.
11. Click on the cell beside Max and type the following formula: =MAX(select all of the data below the year 1995). Press Enter.
12. Click on the cell beside Q3 and type the following formula: =QUARTILE(select all of the data below the year 1995, 3). Press Enter. Note that the number 3 at the end of the formula calculates the third quartile.
13. To easily calculate the statistics for the other years, highlight the cells containing the values for Q1 through Q3. Click on the bottom right corner of the region and drag right to fill in the values for the remaining years.
14. Save the lab at this point to make sure you don’t lose anything.

III. Create Box Plots
15. Decide on two years to compare. Highlight the words starting with Q1 down to Q3. Press and hold the CTRL key to select the data corresponding to two of the years. Highlight only the values, not the title.
16. Click on the Insert tab. In the Charts section, select Line and choose the Line with Markers option.
17. Make sure the chart is selected. There should be Chart Tools at the top. In the Design tab, select Switch Row/Column on the far left in the Data box.

18. You should see five lines in the chart window. Now we are going to delete these lines because we are only interested in the markers.

19. Left click on a line so that only one line is selected. Right click and select Format Data Series.

20. Click on Line Color on the left and choose No line then click on Close. Repeat this for the other four lines.

21. Make sure the chart is selected. Under Chart Tools, select the Layout Tab. In the Analysis box, choose Lines and select High-Low Lines. In the Analysis box, choose Up/Down Bars and select Up/Down Bars. You should now see two box-plots in your chart.

22. Left click then right click on the numbers 1 and 2 at the bottom of the chart and choose Select Data.

23. Press Edit under the Horizontal Axis Labels.

24. Click on the year for the first set of data that you chose, then type a comma and click on the second year. Click OK. The years should appear below the corresponding box plot.

25. Add a chart title. In Chart Tools, select the Layout tab and click on Chart Title. Select Above Chart. Type a title that has your continent and Mortality Rates for Children Under 5, per 1000 Live Births. You may also put the years you selected in the title if you want. Format it however you think works with your chart.

26. Save your lab.

IV. **Post graphs to Weebly on your country page.**

These are similar instructions as those on the bar chart lab.

27. Open the Paint program in Windows. Click on Start and All Programs. Select the Accessories folder and choose Paint.

28. Click on the Boxplot in Excel and make sure the entire chart is selected. Under the Home tab click on the Copy icon or right click on the chart and select Copy.

29. Switch to the Paint program and paste the chart into the white area using either the Paste icon or right click and choose Paste.

30. Click anywhere in the gray region of the Paint program to unselect the chart. Move the white region of Paint to match with the corner of the chart.

31. Click on the Save icon and save the Chart image as a PNG, JPG, or GIF file. JPG is generally the one used for images. Save it to My Documents or the Desktop to easily find it again.

32. Open an internet browser and go to your website. Drag and drop the image icon at the bottom of your page. Click on the image and select the option “Upload a photo from your computer”.

33. Below the chart make a comparison of mortality rates during the two years selected using the two box plots.
MAT 155 - Gapminder Analysis of Data

The gapminder.org website will be used to create analyses of data. The graphs will then be posted on the website as part of the students’ international project.

I. Group Assignment
1. As a group choose one person to open an internet browser page.
2. Go to www.gapminder.org.
3. Click on the tab at the top entitled Gapminder World. This will load a chart that is titled Wealth and Health of Nations.
4. Read or skim over the printed copy of the Gapminder World Guide to have an idea regarding the tools for creating a map.
5. Select the three countries for your group on the right of the chart. If you have trouble seeing the country marker, you can click and drag the name of the country to anywhere on the graph.
6. Press PLAY and take note of major and minor changes in the data for each country. Note the year and how the income/life expectancy changed.
7. If the data are all jumbled together and it is difficult to see, click on the Magnifying glass with the plus sign in it and click and drag around the data set (like you would if you were cropping a picture). Then hit play again to see the zoomed in video.
8. Open the Paint program. Click on Start, select All Programs, select the Accessories folder, and choose Paint. Switch back to the website.
9. At the top of the graph, click on Full Screen. Make sure the graph has played to the year 2011 and you can easily see the trails of each of the three countries.
10. Press and hold the function key (Fn) and press F11 to Print Screen.
11. Switch back to the Paste program and paste the screen of your graph into the Paint program.
12. Press the Select icon. Select the image of the chart including the axes on the left, the geographic regions and country names on the right, the Chart and Map tabs at the top and the years and Population Total at the bottom.
13. Once the chart is selected, then click on Crop to cut off the excess of the webpage.
14. Save the picture to your desktop as a jpg with the file name: Gapminder-Your Name.
15. Open the Weebly website: students.weebly.com and login.
16. On the Home page, drag down a Picture icon to the bottom of the page. Click on the Picture icon and click on Upload a photo from your computer. Find the picture on your computer and Open it so that it appears in Weebly.
17. Drag and drop a paragraph icon below the picture of the graph.
18. First, you should reference the Gapminder.org website and in one sentence or less explain the axes of the graph. Adding to this paragraph, each student should look up some brief information about what happened in your particular country during the year(s) when the data seem a little strange. Place a link at the end of the paragraph referencing where you found the information.

II. Individual Assignment
1. Select your individual country.
2. Change the axes to find one positive linear correlation between two variables. Make this relative to your group issue. Copy the resulting graph to Weebly and add to your country page. Reference Gapminder.org below the graph and explain what the graph represents.
3. Change the axes to find one negative linear correlation between two variables. Make this relative to your group issue. Copy the resulting graph to Weebly and add to your country page. Reference Gapminder.org below the graph and explain what the graph represents.
Preview Lab 10 - Worldmapper Lab
Note: This quiz is not currently available to your students

Question 1
Marks: 1
Click on the Map Categories box at the top of the page.
Click on the link for Cause of Death in the bullets on the left of the screen close to the bottom of the list.
You should see a list of causes of death for the entire world in 2002.
Click on the words All Deaths at the top of the table.
Fill in the blank below based on the paragraphs beside the map describing this category.

The total number of deaths from every possible cause is called ________.

Answer: ____________________________

Question 2
Marks: 1
Click the Back arrow to go back to the list of causes of Death.

State the number that represents the total number of deaths. (Listed beside All Deaths)

This will be the number used as the sample space for some of the probability calculations.

Answer: ____________________________

Question 3
Marks: 1
Using the table of causes of death and the world totals for each cause...

Calculate the probability of a randomly selected person dying of pneumonia.

Round answer to four decimal places.

Answer: ____________________________

Question 4
Marks: 1
Using the table of causes of death and the world totals for each cause...

Calculate the probability of a randomly selected person dying from an accident (any type of accident).

Round answer to four decimal places.

Answer: ____________________________

Question 5
Marks: 1
Using the table of causes of death and the world totals for each cause...

Calculate the probability that a randomly selected person will die from Hepatitis B or Hepatitis C.

Round the answer to four decimal places.
Calculate the probability that a randomly selected person will die from a digestive tract disease or a skin disease.

Round the answer to four decimal places.

Answer:

Calculate the probability that a person with cancer will die from stomach cancer.

** Note that the sample space has changed from all people in the world to just those with cancer.

Round the answer to four decimal places.

Answer:

Calculate the probability that a randomly selected person with a nutritional deficiency will die from starvation.

** Note the sample space has changed from all people in the world to just those with a nutritional deficiency.

Round the answer to four decimal places.

Answer:

Choose the correct interpretation of this probability from the choices below. Choose one answer.

- a. 2.74% of people with Tuberculosis will die.
- b. 2.74% of the time a person will die of Tuberculosis.
- c. A randomly selected person will die from Tuberculosis 2.74% of the time.
- d. There is a 2.74% chance that a randomly selected person will die from Tuberculosis.
Click on "Deaths of Women from Pregnancy". The map created shows the proportions of each country with women who have died from pregnancy. Notice that you can barely see the U.S. because there are very few women who die from pregnancy in the States.

To compare this map with a map of population, click on the population map in the lower right corner. If you hover over the countries in the population map, you will see the names of each country. All countries have the same color in both maps.

Choose from the list below all countries that have a high proportion of deaths from pregnancy based on comparing the two maps.
Choose at least one answer.

☐ a. Brazil
☐ b. Nigeria
☐ c. Australia
☐ d. India
☐ e. China
☐ f. Ethiopia
☐ g. Democratic Republic of Congo

Based on the paragraphs to the right of the proportion map for deaths of women from pregnancy in 2002,
maternal conditions caused what percent of all female deaths and what percent of all deaths among all adults between ages 15 and 59 years.
Choose one answer.

☐ a. 3.2%, 1.9%
☐ b. 1.9%, 3.2%
☐ c. 3.3%, 6.4%
☐ d. 4.7%, 3.1%

Click on the tab for Map Categories. Choose Violence in the bullets on the left of the screen. Select the map for Landmine Casualties.

Name one of the four countries with the largest proportions of landmine casualties.
It is very important to note the color of the country along with the surrounding countries to be able to choose the correct ones. Compare with the population map for the correct name of each country.
Answer:

Question 13 📝
Marks: 1
From the paragraphs beside the map, between 2003 and 2005 there were almost how many landmine deaths and casualties a year worldwide?

Answer:

Question 14  
Marks: 1

Click on the Map Categories tab. Click on the bullet for Communication. Select the map for Cellular Subscribers 2002.

Based on the proportions of each country, which country has the largest proportion of cell phone subscribers? Choose one answer.

- a. France
- b. United Kingdom
- c. Japan
- d. China
- e. United States
This is a follow-up to Lab 10 for the International Project. This will be completed individually using the website www.worldmapper.org.

1. Click on Map Categories. Select a category that relates to the global issue for your group. There may be more than one category that relates to your issue, so just choose one.
2. Browse the different maps created for your global issue and choose one to display and explain on your website. Each member of your group should choose a different map.
3. Once you have chosen your map, click on the actual map to make it full-size.
4. Copy the URL for this map.
5. Open a new window or tab and go to education.weebly.com.
6. Log into your Weebly website. Drag and drop a Paragraph with Picture box to your page of the website.
7. Click on the Image icon and select the tab for Image URL.
8. Paste the URL for your map website in the bar and press Insert. You should see a picture of the map that you chose.
9. Click on the worlds “click here to edit”. Type a paragraph that includes the following information:
   - A reference to the worldmapper.org website or hyperlink for it.
   - Explanation of what the map represents
   - How the map represents the information
   - Description of a few of the most interesting parts of the map in relation to your global issue
10. Publish your information.
Introduction – Explanation of Course by Instructor
  - Introduction
  - What is MAT 155?
  - Explain how project is setup and how groups were created using survey

International awareness – Each student should say one thing interesting about their country during the presentation

Group 1 - Website Creation
(Some examples of what to talk about)
  - How each student chose country
  - Brief description of Weebly website
  - How groups setup website with country names and global issue
  - Home page was collaboration of group/individual pages were for each country in the group
  - Difference between page and blog
  - Different international websites used for project

Group 2 – Website Content
(Some examples of what to talk about)
  - Major things added to the website and how
  - Graphs/Tables/Blog...posts, videos, comments
  - International Images – Creative Commons
  - Keep international aspect in mind when talking about this

Group 3 – Challenges of Project
(Some examples of what to talk about)
  - What were the most difficult parts of the project
  - What were the easiest parts of the project

Group 4 – What You Learned or Thought about Project
(Some examples of what to talk about)
  - Website creation process
  - Using international data
  - About the global issues
  - About working with other students on global issues

Questions from audience
MAT 155 – International Project
Presentation (1 -2 min per person)

Social Issue for group –

Group – Write the name and country for each member of your group.

Key Talking Points – Under your name write down a talking point for each member in your group relative to
the topic you are presenting. Also make a few bullet points about what you will be talking about. This is a
passport event, so each group needs to keep the international aspect of the project in mind when
presenting.

Interesting Fact – Each member of the group should also write down one interesting piece of information
they learned about their chosen country.

Member 1:

Member 2:

Member 3:
MAT 155 International Project - Grading Rubric

I. Website Design (25 points)
   a. Group – General Setup/Home Page
      ___ Website should have 5 pages – Home page, 3 country pages, Blog page
      ___ Title of website based on Global Issue
      ___ Image representing issue
      ___ One or two brief statements on importance/relevance of issue
      ___ No random buttons that don’t link anywhere in entire website
      ___ Type the names of each student in group as Authors on the right of the blog page
      ___ Website (Home Page) should be easy to read and follow
      ___ Creativity of group – design selection, image selection, etc.
   b. Individual
      ___ Student name somewhere at the top of individual page
      ___ Map of country
      ___ Easy to read and understand flow of page

II. Content (50 points)
   a. Group
      ___ Table or list of quantitative/qualitative variables for each country in group (on home page or individual page)
      ___ Blog Post for classmates – Can you find an interesting statistic?
      ___ Bar chart with comparison of countries
      ___ Video blog post about issue
      ___ Gapminder graph showing the three countries. Brief description of strange data in the graph.
   b. Individual
      ___ Blog response for interesting statistic on at least one website from class
      ___ One observational study or experiment about group issue. Must have link to study. Must have explanation of why you think it is an observational study or experiment.
      ___ Bar chart of individual country
      ___ Descriptive statistics of weather in individual country
      ___ Comment on all other group videos on Blog page
         Group 1 ___ Group 2 ___ Group 3 ___ Group 4 ___
         Group 5 ___ Group 6 ___ Group 7 ___ Group 8 ___
      ___ Mortality rate box plots for continent containing your country – brief explanation of graphs following
      ___ Gapminder graphs – one showing positive correlation, one showing a negative correlation. Brief explanation for each.
      ___ Worldmapper.org proportion map with explanation of map

III. Presentation (25 points)
   Each person in the group must:
   ___ Submit talking points before presentation
   ___ Have a speaking part about particular talking point
   ___ Stay on topic and not ramble when speaking
   ___ State an interesting fact about their chosen country
   ___ Be quiet and courteous while other groups are speaking